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This community service activity aims to develop the potential of Raudhatul
Athfal (RA) teachers as a teacherpreneur, especially in the information and
communication technology field. The ability of RA teachers to face the era of the
industrial revolution 4.0 requires improving skills in the digital technology
field—an effort to improve teacher welfare. Using training and mentoring
methods, RA teachers are introduced to the Inkscape computer graphics program
to support the creation of visual props for learning media, especially early
childhood character development. The community service activity produced
several illustrated stories made by the trainees that showed a change in the ability
of RA teachers to use the Inkscape program as an accessible free digital image
medium. Furthermore, by using Inkscape, RA teachers can create a digital
drawing with tracing techniques so that anyone can create a storytelling picture
themselves. In addition, teachers are also introduced to the microstock platform,
which is currently widely used as a forum for publishing graphic design works
and becoming a website for buying and selling digital products. Therefore, it is
hoped that teachers can start becoming teacherpreneur in today's digital era.
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Introduction

Early Childhood Education (PAUD) teachers in Indonesia
still have below-average standards. One of which is in the
educator standard. A recent survey showed that 52% of ECCE
teachers in Indonesia still have high school qualifications, as
conveyed by the Head of PP PAUD and Dikmas West Java, M Hasbi
(Lukihardianti, 2017). The above conditions certainly impact the
quality of learning in ECCE, so few implementations of learning in
the field occur in many “malpractice,” especially at the ECCE
level. As one of the illustrations, many teachers still teach early
childhood (primary or secondary school) and provide learning
that is too dominant in academic aspects. Therefore, it impacts
the learning methods and techniques used to assign assignments
through worksheets for children. According to Tedjasaputra
(Saepudin, 2013), children who have been given a dominant
education oriented towards academic aspects will make the
child’s life less prosperous, meaning that the opportunity for the
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child's golden days through playing is lost. This is because there is essentially a phase of cognitive
development in which children have an ideal pattern, namely the period of childhood to adolescence;
cognitive development will be predominantly obtained through play activities—spontaneous and
structured in school (Claudia et al., 2020; Kristiana, 2018).

Learning models using visual props is the right way for teachers to impart knowledge to
students early. Images are easier to understand because they are a universal language (Anggraini &
Nathalia, 2016). However, the problem of ECCE teacher competence mentioned above is an obstacle
for teachers in preparing teaching materials in the form of visual media following the target of student
learning outcomes and childhood education achievement. The ECCE teachers need to gain more
mastery of information and communication technology. Meanwhile, ECCE teachers' educational
background is generally not prepared to face the challenges of today's digital era. Therefore, the
community service team has compiled an activity that is expected to make a real contribution to RA
teachers to improve their competence in the field of ICT. In addition, this will also motivate RA
teachers to develop their potential to become teacherpreneurs as a form of self-development suggested
by the Indonesian minister of education.

PC IGRA, as a partner of PKM, has assigned representatives of RA teachers in their regions to
be trainees. There are 34 RA who have teachers with various educational qualification backgrounds,
and there are about 130 teachers ranging from high school graduates to tertiary institutions. As for
linear, only about 30 teachers graduated from S1 PG PAUD. However, most of them have received
competency development empowerment training for RA teachers, including the 2013 Curriculum
Training, Fun Calistung, drawing empowerment, and storytelling. Of all the empowerments that the
PC IGRA has organised in the Cicalengka district, this is the first time anyone has specifically
developed a teaching capacity improvement program in ECCE.

However, RA teachers have never conducted activities related to mastering digital technology
and teacherpreneur. In line with the program that PC IGRA Cicalengka District has planned, the PKM
team of the Community Partnership Program, with support from the Institute for Research and
Community Service at the Islamic University of Bandung, will carry out empowerment to improve
teaching competence for RA teachers. This is a solution to improve teachers’ skills in teaching
practice and skills to create ICT-based learning media and motivate them to be a teacherpreneur.

Research Method

The training and mentoring method is used in this community service activity to improve the
skills of RA teachers using the Inkscape computer graphics program as a tool for drawing illustrations
on visual props as teaching media. Data collection techniques through interviews and observations in
the field to obtain an overview of the actual situation related to the learning model at the PC IGRA
institution. The training and mentoring duration are for eight hours consisting of several materials,
namely; 1) Teaching Skills, 2) Knowledge of visual thinking and language, 3) Introduction to the
Inkscape graphics computer programs, 4) Practice of creating visual props, 5) Knowledge of
teacherpreneurs and microstock platforms. The community service activity location at PC IGRA
Cicalengka District with participants consisting of representatives of RA teachers throughout the
Cicalengka sub-district, as many as ten people. Trainees are limited because of place and time
constraints to ensure that training objectives can be achieved optimally.

Results & Discussion

Based on the findings in the field, in general, found several problems for RA teachers in the
Cicalengka area: 1) Most RA teachers are high school level graduates (SMA); 2) they graduated
from non-Education for Early Childhood Education; 3) fewer teachers are undergraduates of ECCE
Education. This, of course, will affect the teaching competence of the teacher in the field. In addition,
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the teaching experience or "flying hours" of RA teachers in the Cicalengka sub-district is still not
long, on average under five years. Hence, it affects the teaching patterns of teachers that fewer
innovations or just continuing the existing teaching patterns. 2) RA teachers still need help developing
information technology-based learning media. Teachers in the digital era must have competencies in
using Communication and Information Technology (ICT) to develop learning media. (Kaynar et al.,
n.d.; Muktiarni et al., 2019; Zomer, n.d.) Coupled with the situation during the Covid-19 pandemic,
ICT is the primary learning medium for teachers in the classroom (Shaleh & Anhusadar, 2021). The
problem in the field is that RA teachers do not master this ICT-based learning media; there are still
many teachers in the classroom using available teaching aids, so they tend not to keep up with the
times. The existing teaching media is used from time to time because it is already available or
provided by the institution. Meanwhile, the material presented may need to be updated.

The two problems above are priority programs for improving the competence of RA teachers
under the leadership of the Head of PC IGRA Cicalengka District, Eva Qori Tartila, namely
empowering the creation of learning media for teachers in Kindergarten (TK) and increasing the
teaching competence of ECCE teachers in the classroom. Therefore, the collaboration offered by the
Community Service Unisba team with PC IGRA received a good response.

The training using the Inkscape computer graphics program received an excellent response from
the trainees because it improved the competence of RA teachers to create visual teaching media based
on digital technology. Although they are new to the Inkscape program, most participants stated that
it is pretty easy to use the application (Figure 1).

Afteryou received Inkscape training, how
was your experience using the
application?

10%

M Easy to understand
W Pretty Easy to Understand

Less Easy to Understand
Figure 1. Participants' Understanding of the Inkscape Program

Teaching Skills

Training in teaching skills is related to teachers' pedagogical competence in the classroom—
first, questioning skills. Questioning skills are essential skills in building students' critical thinking.
This skill has several forms, e.g., query, rhetorical, directing, guiding, and digging questions.
Secondly, skills provide reinforcement. This skill is part of giving confidence to the child; the child
IS expected to dare to return to answering questions or executing orders or assignments. Third, the
skill of making stimulus variations. This skill requires the teacher to develop the lesson's activities
more creatively.

Children need to be given a variety of activities so that boredom can be avoided. Fourth is the
skill of explaining. This skill directs teachers to convey information to children who still need to think
abstractly to convey it systematically and efficiently understood by children. Fifth, the skill of
opening lessons. According to experts, success in one day of kindergarten learning activities begins
with opening activities. Teachers must be able to invite children with various backgrounds and
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situations at home before coming to school with the same goal of wanting to carry out learning at
school. Sixth is classroom management skills. These skills aim to create and maintain a conducive
learning and teaching climate. Learning barriers often come from students, such as being too noisy,
disturbing friends, and studying back and forth in class. Seventh, guiding group discussions.
Especially for kindergarten children, the discussion is simple; the topic is just an introduction. The
goal must remain, but it does not reach the child who can solve the problem. The most important
thing is that the child can already be taken towards the discussion situation, talk together, sit facing
each other (circle), and there is a topic of discussion conversation. Eighth, skills close the lesson. This
skill invites children to recall previous learning experiences. Considering that children still have a
short memory, the teacher must repeat the material that has been delivered so that it can still be
remembered and applied by the child.

Visual Thinking and Visual Language

The second training focused on improving teachers' skills in making learning media based on
visual communication. The first material is about Conceptualizing Children's Stories. A children's
book author must understand the psychology of child development to understand children's points of
view and what information is appropriate to write, as well as understand children's liking for
storytelling (Trimansyah, 2020). Early childhood is already taking an interest in storybooks,
especially picture storybooks. Special children's magazines, such as Bobo magazine, can be counted
on the fingers. However, the magazine's content is more aimed at early readers or pre-literacy. A
suitable storybook for early childhood is a storybook with no words. This type of book is a storybook
that almost one hundred per cent uses images for its story, so it is aimed at developing the cognitive
and affective aspects of the child to infer the events or activities depicted. Through storybooks with
no words, early childhood is stimulated to develop their logic and, at the same time, practice their
language. However, using non-story picture books requires assistance from teachers and parents,
especially for children who have difficulty imagining their storylines.

The second kind is picture storybooks. This book contains short stories for children with a little
narrative. Also called a picture book, the portion of images or illustrations in picture books is
dominant up to 70-90 per cent. Picture storybooks are aimed at pre-read readers and early readers. In
the picture book, there are only a few words or sentences to usher in the story.

After understanding the correct storybook type for early childhood, the next stage is
determining the story's theme. The theme of children's stories generally comes from simple things
but appealing to children. Remember, those storybooks for children are about more than just showing
a story without conveying any values. Based on the nine pillars of character in the Indonesian Heritage
Foundation, story topics can be developed to develop early childhood characters, such as cooperation,
caring for the environment, and mutual respect. To convey the message of these character values, the
author of a children's storybook needs to establish a character and characterization. The characters in
the story can be who and what, such as humans, animals, or inanimate objects brought to life
(Trimansyah, 2020). However, in conveying the message of character values, it is more effective if
the main character is the child himself because, in the pre-reading period, the child will imagine the
story, which can strengthen the memory of the message in the child's mind. In this case, the author of
children’s stories must be able to provide opportunities for the main character of children to solve
their problems even though the child has limitations.

The next stage is the setting, both place and time. The setting can be where the child is playing
at home, in the field, at school, or in a broader area such as a village, a city, and a specific geographical
location. In addition, there are also setting places that for children are very interesting such as the
beach, mountains, the king's palace, or even outer space. Folklore-based stories usually use the phrase,
"in antiquity..." or "Once upon a time when animals could speak like humans...". The time setting
becomes explanatory in historical stories, for example, a biography of the lamp's inventor or an
independent hero figure (Trimansyah, 2020).
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The storyline used by the author to explain event after event experienced by the story character
is contained in the plot or plot. In the storyline, there are usually conflicts faced by the main character.
However, in stories for children, the conflict is made less complicated. Conflict becomes an attraction
in the story; children, as readers who have great curiosity, then the existence of conflict helps children
to learn to find solutions or develop their rationalism.

The last is a visual language. Visual language is another ability of the author of a children's
storybook to create illustrated stories for pre-read or pre-literacy children. There are three interrelated
aspects of visual thinking: Seeing, Imagining, and Drawing (Mohamad Taufik & Taufik, 2012). To
develop visual thinking skills, it is necessary to train visuals in seeing objects around us. The images
displayed in children's storybooks do not have to be realistic but can be imaginative, just like
children's minds.

Inkscape Basic Practices

Inkscape is a vector image editor software freely open under the GNU GPL license. The main
goal of Inkscape is to create cutting-edge graft devices that meet XML, SVG, and CSS standards.
Inkscape is available for Windows, Macintosh, and Linux operating systems. Inkscape programs and
source code are publicly available on the official Inkscape website, so anyone can learn and develop
them. Inkscape can be downloaded via the official website, https://inkscape.org, for free.

Starting this application is to set up canvases and pages. So when making drawings easier, we
should do the work page settings first. To make the Canvas (work area) and page settings, click File >
Document Properties or press Shift+Ctrl+D.

Understanding Inkscape tools, including Display units, are used to set the size type of ruler or
ruler; the default size of the new Inkscape page is px. However, when creating a project, the size has
been changed, then save the project and one day reopen it. Then the size used corresponds to the size
that was changed last time. Page Size is used to select and set the size of a page or pages; there are
several commonly used size options, such as A4, letter, or A3. In addition, there is also a choice of
page positions; portrait or landscape. The background is used to set the background color of the
Canvas. The color that appears is only the appearance. To change the canvas background, do the
following: click the canvas color indicator to the right of the Background text; in the settings
subwindow that appears, select the appropriate tab and color; after corresponding, close the
background color setting subwindow again. The border is used to display lines or frames on the edge
of the page, and there are 3 (three) submenus to adjust the frame's appearance.

The color on the object is filled with Fill. For example, a square field is green, meaning the
object has been filled in green. To select fill, the,n select Menubar Object > Fill and Stroke. In addition
to the object's color, p[un has a borderline called Stroke. For example, the square plane is green, and
the line on the edge is black.

Drawing with Tracing Techniques

Prepare in advance the photos to be traced. For example, please take a photo of a child using a
camera, and save it in a computer drive. Open a new document and import the photos from your
computer's storage folder. File menu > Import..., select the image in the exact location, select the
image in the same location, click Open, a dialog box will appear, click ok.

Then, add a layer above the photo layer. Select the layer icon in the menu bar, and a layers
panel will appear, then first lock layer 1 (photo). Then select add layer; a dialog box will appear, and
click add. A new layer (layer 2) will appear in the layers panel. Then select layer 1; we will make this
layer transparent to make it easier for us to trace. Please hover over the bottom of the window, and
look at the options bar; there is a column of Opacity contents, giving it a value of 50. Then the
brightness of the child's photo will look faded.

Next, select the Bezier tool to outline the child's photo. We have previously selected layer 2 for
our working page. Then point the Bezier tool to the photo and click drag to create an outline. Create
an entire outline, starting from hair, face, ears, eyes, and nose, so it is complete (Figure 2).
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Figure 2. Plagiarizing Photos W|th Tracmg Image Technlques Using Inkscape

When we are done creating the outline, it is time for us to color it. Use the color palette at the
bottom, using the Arrow tool, select the hair outline, and then click the black color for the hair in the
color palette. Do the same for the other objects. Please save your work in .svg format so it can be
used to create merges of objects in the future.

Furthermore, taking pictures of the anatomical parts of the hands, feet, and body still use the
method of plagiarizing. We first prepare the image that we will trace it. Here we can use vector images
available on microstock platforms such as www.vecteezy.com and search for the images we need.
The images available on the site are not all free to download. We need to screenshot (SS) the computer
screen to get the image that will be used as a reference source. Then the SS results are imported into
the Inkscape document that we prepared.

Open a new document, then import the prepared SS image from the storage folder on the
computer. File menu > Import..., select the image, click Open, a dialog box will appear, click ok. As
a first step in tracing the body on Layer 2, use the Bezier tool with a colorless fill and a black stroke.
Adjust the size of the stroke thickness in the stroke window. Follow the outline of the reference image
to create a "Hand" image. Edit the Path so that it becomes neater by using the Edit Path tool by sliding
the nodes (small squares) on the outline of the image. When finished, the selection of all hand lines
is combined by pressing the key combination Ctrl + G or right-clicking > Group (Figure 3).

Jia

\..;

<.

1)})/@%

Figure 3. Stages of making a hand drawing by the method of plagiarizing

S— bl PR —

Next, we make the other hand part. We do not need to recreate it but can duplicate an existing
hand object by slightly editing it using the Edit Path tool. Select the hand object, then right-click on
the duplicate > hand object (Ctrl+D) or select the Edit > Duplicate menu.
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The body creation step is the same as creating a hand, using the Bezier tool, following the
outline of the reference image, and using the Edit Path tool to smooth the tracing results.

After the participants understood how to create illustrated story image media using the Inkscape
application, the participants were then given material about teacherpreneur to the teacher. Creating a
microstock platform user account is a stage of introducing teachers to the entrance to becoming a
teacherpreneur in the digital era. It takes a long process to provide financial benefits using the
microstock platform. Several game rules must be obeyed by the developers of this platform, one of
which is continuity in work.

This training activity received positive appreciation from the participants. As a follow-up, the
participants were tasked with creating a picture of a non-speech illustrated story with the theme
referring to the nine pillars of the Indonesia Heritage Foundation.

The Inkscape application with mentoring and modules accelerate participants' understanding
and increases creativity (Purnomo et al., 2021; Suhartono et al., 2021). Based on the survey, the need
for digital content creation skills is critical, followed by creating digital classrooms and mobile
learning. This two-dimensional story image media can provide positive results for learning outcomes,
especially in early childhood (Slamet et al., 2020; Wahyudi & Setyonugroho, 2020).

The income of ECCE teachers in Indonesia, which is still relatively below the national income
standard, especially during the pandemic two years ago, made many ECCE institutions collapse,
requiring a push to improve the welfare of teachers. Therefore, teachers must improve their abilities
in the field of entrepreneurship, including through teacherpreuneur or technopreneur training.
(Purwandari & Achmad, 2022).

Conclusions

Community Service Activities in the context of Training on Making Teaching Media Based on
the Inkscape Application to Grow the Teacherpreneur Spirit in Teachers Raudhatul Athfal have
provided positive benefits. This is based on the results of interviews with the participants. Participants
obtain two advantages. First, participants have begun to have the basic skills of making visual props
with the Inkscape application to develop teaching media, innovate, and be up-to-date. The two
teachers were also encouraged to develop the story images' media so they could be uploaded to the
microstock platform. In turn, they were accustomed to doing work. It was hoped that the works could
continue to be improved in quality and receive appreciation from users of the microstock platform,
impacting the incentives obtained later.
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